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ABSTRACT

Magneto rheological abrasive flow finishing (MRAFF) is used to finish complex internal and external geometries with the help of magnetorheological polishing fluid. Such finishing operations play a crucial role in manufacturing process of machine parts. The cost escalates sharply when the requirement is to achieve surface roughness values near nano levels. The need for finishing is to avoid power losses due to friction, increase the wear resistance and to provide a long serviceable life to the equipment. MRAFF is a time consuming process and any effort to reduce the process time even marginally saves production time and cost of the finished product. Researchers have often strived to improve finishing rate and MRR. An attempt has been made to overcome the said limitations, a new finishing process called rotational magneto rheological abrasive flow finishing (R-MRAFF) is developed, which is a combination of rotational abrasive flow machining (R-AFM) and magneto rheological finishing (MRF), for nano finishing of parts even with complicated geometry for a wide range of industrial applications. Rotational magneto rheological abrasive flow finishing (R-MRAFF) process provides better control over rheological properties of abrasive laden magneto rheological finishing medium. Magneto rheological (MR) polishing fluid comprises of carbonyl iron powder and silicon carbide abrasives dispersed in the viscoplastic base of grease and mineral oil. It exhibits change in rheological behaviour in presence of external magnetic field. This smart behaviour of MR-polishing fluid and centrifugal force due to rotation of rams is utilized to precisely control the finishing forces, hence final surface finish.

           In the present work, an attempt has been made to analyze the total force acting on the single grain at different magnetic field strength and rotational speed and a model for the prediction of volumetric material removal and surface roughness has also been presented. A three dimensional modeling is done to calculate force acting on the single grain. In order to rotate the magnetoreheological polishing fluid (MRPF), rams of the machining system are joined together with the help of a connecting rod. Modeling was done on brass work piece at different magnetic field strengths and at different rotational speeds to observe its effect on final surface roughness and volumetric material removal. No measurable changes in surface roughness a observed after finishing at zero magnetic field and at zero rotational speed. However, for the same number of cycles, the roughness reduces gradually with the increase of magnetic field and rotational speed. This validates the role of centrifugal force and rheological behaviour of magneto rheological polishing fluid in performing finishing action. The present study shows that with the rotation of MR polishing fluid, an extra component of centrifugal force (Fc) adds up to the resultant force which increases the volumetric removal rate and surface finish as compared to other finishing processes.
Keywords: Magnetizable unbonded abrasive, RMRAFF, 3D modeling, Surface finish.
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INTRODUCTION AND PROBLEM FORMULATION                                              1
1.1 INTRODUCTION

Precision finishing of internal surfaces and complex geometries is always of concern being labour intensive and difficult to control. Small multiple cutting edges of abrasives are generally used to obtain desired geometrical accuracy and surface characteristics by removal of unwanted superfluous material from the workpiece surface. All traditional finishing processes (grinding, lapping, honing, etc.) work on this mechanism of finishing. Due to the development of new difficult-to machine materials and complex geometrical shapes of engineering components, the available traditional finishing processes alone are incapable of producing required surface finish and other characteristics. Even if these processes can be used, they require expensive equipments and skilled labour, hence making them economically incompetent. Developments in advanced finishing processes in the last few decades have attributed to the relaxation of limitations of tool hardness requirement and restricted predefined relative motion of cutting edges with respect to workpiece surface. Use of alternative source of energy like electrical, chemical, mechanical or thermal to assist or perform machining relaxed the constraint of using cutting tool harder than the workpiece. Electric discharge machining (EDM), electrochemical machining (ECM), ultrasonic machining (USM), abrasive jet machining (AJM), laser beam machining (LBM), etc. are a few instances of such techniques. Predefined relative motion of the cutting edge with respect to the workpiece surface is a major limitation in finishing complex geometries. To overcome this limitation, the multiple cutting edges in some loosely bonded form are directed to follow the intricate geometries to be finished. Abrasive flow machining (AFM) is one such advanced finishing process which uses abrasive laden viscoelastic polymeric medium for finishing.
Precise control of finishing forces is another important consideration for fine finishing with close tolerances and without damaging surface topography. The major bottleneck in existing finishing technologies lies in incapability in controlling abrading forces, hence final surface finish. The nature and strength of bonding material used to hold the abrasive particles together determines the extent of abrasion and quality of the finished surface. Advanced fine finishing processes in which efforts were made to precisely control the abrading forces are magnetic abrasive finishing (MAF), magnetic float polishing (MFP), magnetorheological finishing (MRF). In MAF, MRF and MFP, the magnetic field is used to control the abrading forces, but the applications of these processes are limited to specific simple geometries. These are incapable of finishing internal intricate shapes and passages.
1.2 CURRENT STATUS OF RELATED FINISHING PROCESSES.
1.2.1 Abrasive flow machining
Abrasive flow machining is one of the latest non-conventional machining which possesses excellent capabilities for finish-machining of inaccessible regions of a component. It has been successfully employed for deburring, radiusing, and removing recast layers of precision components. High levels of surface finish and sufficiently close tolerances have been achieved for a wide range of components in AFM, a semi-solid medium consisting of a polymer-based carries and abrasives in a typical proportion is extruded under pressure through or across the surfaces to be machined. The medium acts as a deformable grinding tool whenever it is subjected to any restriction. A special fixture is generally required to create restrictive passage or to direct the medium to the desired locations in the work piece.

Extrude hone corporation, USA, originally developed the AFM in 1966. Since then a few empirical studies have been carried out. It is gaining widespread attention due to its ability to produce consistent and predictable results. The edge quality and surface finish can dramatically improve product performance and lifetime. Removing stress raisers at sharp corners by producing controlled radii on edges can substantially improve thermal and mechanical fatigues strength of highly stressed components. In this process, an abrasive – laden pliable semisolid compound is forced to and fro across the surface to be machined. The abrasive action during AFM depends on the extrusion pressure, flow volume and media flow speed determined by the machine setting in relation to media type, passage area, and media formulation which includes media viscosity and abrasive type and size. 

AFM ensures the component accuracy, process efficiency and economy, and effective automation needed. Additional benefits over traditional finishing processes include a substantial time saving and better control with regard to the accuracy and square ness of the bearing surfaces. In the first few cycles it results in about 90% of the total improvement in the surface finish, with minimal dimensional change (usually 0.013 to 0.025mm).
Abrasive flow machining system consists of three components
1. Machine – Machine having two cylinders and abrasive media controls the extrusion pressure. The media is extruded (or forced) back and forth from one cylinder to another with the help of hydraulic ram. These cylinders / chambers are clamped together with the work piece sandwiched between them. The controllable variables are volume of media, no. of stroke, number of cycles and pressure.

2. Tooling – It is an element which is used to confine and direct the flow of media to appropriate areas and to selectively permit or block the flow of media into or out of work piece passages where deburring, radiusing and surface improvements are desired. Tooling also holds the parts in position
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Fig.1.1 Schematic diagram of abrasive flow machining setup: 1 – hydraulic oil inlet/outlet port, 2 – hydraulic cylinder, 3 – medium cylinder, 4 – smooth entry profile, 5 – Top cover plate, 6 – dynamometer for force measurement, 7 – central hub, 8 – split cylindrical fixture with workpiece, 9 – bottom cover plate, 10 – support frame, 11 – hydraulic oil outlet/inlet port, 12 – medium with abrasive particles..
.

3. Media – Characteristics of media determines aggressiveness of actions. AFM media is easily moulded material which is resilient enough to act as a self deforming grinding stone when forced through a passageway. It consists of base material and abrasive grit. The base material (viscoplastic /viscoelastic material) is made up of an organic polymer and hydrocarbon gel. Composition of base material determines its degree of stiffness. The stiffest material is used for largest hole, while soft media is used for small holes. High stiffness of media results in a kind of pure extrusion while soft media will flow in the centre than along walls. The semisolid abrasive media is forced through the work piece or through the restrictive passage formed by work piece and tooling together. Force may be applied hydraulically or mechanically. Velocity of media is governed by cross-sectional area of passageways. More the restriction offered by the passageway, larger is the force required.
For the media types of abrasive used are Al2O3, SiC, cubic boron nitride (CBN) and diamond (written in the order of their increasing hardness and cost). These abrasives are available in different grit sizes. These abrasives have limited life. As a thumb role, when the media has machined an amount equal to 10% of its weight, it must be discarded. To assure a proper mixing of a new batch of media and abrasive, it should be cycled 20-50 times through a scrap part. Machined parts should be properly cleaned before use, by air or vacuum.   In this the abrasive particles act as cutting tools; hence it is a multi-point cutting process giving very low MRR. .It is employed for both metals and non-metals. It is equally suitable for work pieces which contain passageways that are not accessible for conventional deburring and polishing tools.
1.2.2 Rotational abrasive flow machining
Rotational abrasive flow machining process is an advancement of the abrasive flow machining process. In R-AFM process, the workpiece is rotated to impart random motion to active abrasive grains which are in direct contact with the workpiece surface. Rotational speed of the workpiece exerts tangential force on the active abrasive grain in contact with the workpiece, which tries to drag the abrasive grain in circular motion.

On the other hand, due to reciprocating motion of the medium, active abrasive grain also moves forward in the longitudinal direction. The resultant motion of the active abrasive grains imparted is helical in nature, and it shears the surface peaks approximately in the helical path. The extent of abrasive action during the R-AFM process depends on the extrusion pressure, medium viscosity, number of cycles, and rotary speed of workpiece. Like AFF,  R-AFF also gives predictable, repeatable and consistent results. However, the major advantage lies in the fact that R-AFF gives better surface finish and higher finishing rate as compared to AFM for the specified conditions.
The R-AFF set-up consists of rotary tooling, variable frequency drive along with high torque motor, speed reduction gear box, external geared tooling workpiece fixture, hydraulic drive and supporting frame. 
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Fig. 1.2 Rotational abrasive flow machining set up.

The primary function of the medium cylinders is to contain the required quantity of medium (homogeneous mixture of viscoelastic polymer material + abrasive particles + processing oil) and to guide the piston during up and down reciprocating motion for extruding medium through the workpiece. The workpiece (hollow cylindrical) fixture and tooling are designed to hold the workpiece and to guide the abrasive medium, respectively. Honed cast iron cylinders and Teflon ring pistons are used to withstand hydraulic pressure without leakage of medium. The input to reduction gear box is given from the variable frequency drive (VFD) via a motor.
 1.2.3 Magnetorheological finishing.

Magnetorheological (MR) finishing is one of the most promising smart finishing methods applicable to such complex surfaces because, by using the variability of the MR fluid’s yield stress via an external magnetic field, it allows a surface to be selectively finished. Since MR finishing is a non-direct contact finishing process, it is the preferred method to attain high precision in surface shape with relatively little damage to the finished surfaces, especially 3D structures. 
When a magnetic field is applied, carbonyl iron particles in an MR fluid form a chain- like columnar structure with embedded abrasives made of diamond, alumina, or cerium oxide. The magnetic interaction force between iron particles provides bonding strength, and its magnitude is a strong function of iron concentration, applied magnetic field intensity, particles’ magnetic permeability, and size. 
It is well known that CI particle chains are aligned along magnetic force lines, and abrasion-type wear occurs when these chains are in relative motion against a workpiece surface.
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Fig. 1.3 Magnetorheological finishing process.

Key Features of MRF includes very high precision finishing of lenses (spherical, flat & a spherical). Surface Finish up to 0.8nm Ra could be attain by this process and this is used for Deterministic Finishing
Not able to work on complex shapes, and ineffectiveness of MR-polishing fluid to polish hard metals are some of its limitations.
1.2.4 Magnetic abrasive finishing

In the magnetic abrasive finishing (MAF) process, granular magnetic abrasive particles (MAPs) [sintered ferromagnetic (iron) particles and abrasive grains (say,Al2O3, SiC, or diamond)] are used as cutting tools and the necessary finishing pressure is applied by an electromagnet-generated magnetic field. Figure 1.4 (a) shows the working principle of the MAF process through a schematic diagram.

The magnetic abrasive particles join each other magnetically between two magnetic poles (S and N) along the magnetic lines of force, forming a flexible magnetic abrasive brush (FMAB). When there is relative motion between the FMAB and the workpiece, abrasion takes place to give a polished finish. This finish can be as good as approaching to 50 nm, depending upon the machining conditions and workpiece material. The performance of the process depends on the parameters such as the MAP (type, size and mixing ratio), the working clearance (the gap between the workpiece surface being finished and the bottom face of magnetic pole), the rotational speed of the poles, the feed motion (x and y motion) of the workpiece, vibration (frequency and amplitude), the properties of the work material and the magnetic flux density.
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Fig. 1.4 (a) Plane magnetic abrasive finishing of magnetic work material (b) Schematic diagram showing the normal (Fmn) and tangential components (Fmt) of the magnetic force (Fm) acting on a magnetic abrasive particle. (c) FMAB and the cutting force (Fc) acting on an abrasive particle.
Figure 1.4 (b) shows the magnetic force (Fm) and its components: the magnetic normal force (Fmn) acting on a MAP due to the magnetic field, and the tangential force (Fc) acting mainly due to the rotation of the magnet (Figure 1.4 (c)). There is a small contribution Fmt to this force Fc as a component of Fm (the magnetic force).

Figure 1.5 (a) shows a schematic diagram of a magnetic abrasive finishing setup for plane surfaces. It shows the major elements of the setup, while Figure 1.5 (b) shows a photograph of a part of a setup.
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(a) (b)

Fig. 1.5 (a) Schematic diagram of plane magnetic abrasive finishing process setup. (b) Photograph of the plane MAF setup: 1 – column of a milling machine, 2 – slip ring, 3 – FMAB, 4 – ring dynamometer, 5 – slip ring attachment

This process can also be used to improve the surface properties by the process of diffusion of traces of MAP into the workpiece surface. Proper tooling can be developed to finish 3D intricate shapes because FMAB adapts to the shape of the workpiece, however it is not as flexible as the AFM medium. Achieving uniform surface finish near the discontinuities or edges in the magnetic poles is difficult. At irregularities, the magnetic flux density is greater, hence the rate of change in surface roughness is also higher compared to other areas. There are various other areas in which research needs to be done, such as workpiece surface temperature and the forces acting on the workpiece during MAF processing. The effect of various parameters on responses such as MRR, surface roughness and out-of-roundness (in the case of cylindrical workpieces) have been reported.

1.3 SUMMERY

· Rotational Abrasive flow machining is a versatile process but lacks determinism and controllability because of real time uncontrollable change in viscosity of polymeric medium.
· Precise control of finishing forces as in MAF, MFP and MRF can be accomplished by using externally controlled magnetic field.
· MAF, MFP and MRF due to their inherent nature of finishing mechanism have limitations of finishing specific shapes only.

1.4 IDEA of RMRAFF PROCESS
· Difficulties involved in medium formulation in R-AFM and lack of deterministically controlling its properties like viscosity, wall shear stress etc. demands to think of better alternatives.
· MRF process relies on unique smart fluid which changes its viscosity in response to external magnetic field and is not able to work on complex shapes, and ineffective of polish hard metals.
In order to maintain the versatility of R-AFM process and at the same time introducing determinism and controllability of rheological properties of abrasive laden medium, a new hybrid process termed as ‘‘Rotational-Magnetorheological abrasive flow finishing (R-MRAFF)’’ which is a combination of Rotational abrasive flow machining and magnetorheological finishing process has been developed as shown in Fig. 1.1. This process relies on rotation of the rams of the system and on smart magnetorheological fluids whose rheological behaviour is controllable by means of external magnetic field. It imparts better control of the process behaviour due to better control over abrading medium’s rheological behaviour.
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Fig.1.6 Development of magnetorheological abrasive flow finishing process.
1.5 BASIC PRINCIPLE OF R-MRAFF PROCESS 
In R-MRAFF process, magnetorheological polishing fluid (MRPF) is used as the polishing medium and finishing forces in this process are controlled by rotation of the rams and rheological properties of MRP fluid. MRP fluid comprises of carbonyl iron particles and fine abrasive particles dispersed in viscoplastic base medium of mineral oil and grease. This composition exhibits unique reversible change in its rheological properties on the application and removal of external magnetic field. The magnetic field dependent yield stress and viscosity of MRP fluid can be controlled by controlling magnetizing current in the electromagnet coils producing magnetic field across the finishing zone. The CIPs acquire magnetic dipole moment proportional to magnetic field strength, and aggregate into chain like structure aligned in the field direction, embedding nonmagnetic abrasive particles in between (Fig. 1.2). Depending on the size and volume concentration of abrasives and carbonyl iron particles (CIPs), the bonding strength gained by the abrasives through surrounding CIPs chains varies. To finish internal work piece surfaces in R-MRAFF process, the MRP fluid was rotated and extruded through the work piece passage in the presence of magnetic field, as shown in Fig.1. 2.

Abrasion occurs selectively only where the change in rheological properties of MRP-fluid takes place from near Newtonian to Bingham plastic due to CIPs chain formation. Due to CIPs chain formation, non-magnetic abrasive particles get embedded between the chains, and rotates with the rotation of rams, due to this, a component of centrifugal force acts on the workpiece in addition to the magnetic force component. In this way, the finishing of the workpiece surface takes place and the extent of abrasion of peaks by abrasives is controlled by rotational speed of the rams and magnetic field strength and the desired finishing characteristics are controlled by changing rotational speed and by changing magnetizing current in the electromagnet.
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Fig.1.7 Mechanism of rotational magnetorheological abrasive flow finishing process.
1.6 OBJECTIVE OF THE PRESENT WORK
The present work “Design and modeling of rotational magnetorehological abrasive flow finishing “has been undertaken keeping into consideration the following objectives:

· Determination of the effects of the various process parameters like magnetic field, current, number of cycles and rotational speed on the performance measures like reduction in surface roughness and volumetric material removal in R-MRAFF process.
· Optimization of the performance measures using Taguchi method. 
· Validation of the Rotational magnetorheological abrasive flow finishing model.

LITERATURE REVIEW                                                                                                 2
In this chapter description of research papers studied for the present work is given ,some researchers has done remarkable work in the field of AFM,RAFM and MRAFF, they investigate the  effects  of process  parameters  like  extrusion  pressure,  number of cycles, viscosity, abrasive concentration  and grain size  on  the  output  responses  namely,  surface  finish and  material  removal, below is the details of the literature review available.

· Das, Manas, Jain, V.K. and Ghoshdastidar, P.S. [1] studied the mechanism of MRAFF process and developed a theoretical model for MRAFF process. They analyze the medium flow through the fixture by finite difference method by assuming the medium as Bingham plastic to evaluate the stresses developed during the process. A capillary viscometer has also been designed by them to study the effect of magnetic field on the rheological properties of the medium. Microstructure of the mixture of ferromagnetic and abrasive particles in magnetorheological polishing fluid (MRPF) has been proposed, and normal force on the abrasive particles is calculated from the applied magnetic field. A model for the prediction of material removal and surface roughness has also been presented. 

· Jha, Sunil and Jain, V.K. [2] developed, designed and modelled a new precision finishing process for complex internal geometries using smart magnetorheological polishing fluid. Magnetorheological abrasive flow finishing (MRAFF) process provides better control over rheological properties of abrasive laden magnetorheological finishing medium. They discuss the effect of magnetic field applied in the process on the magnetisable abrasive. A hydraulically powered experimental setup is designed to study the process characteristics and performance. The setup consists of two MR-polishing fluid cylinders, two hydraulic actuators, electromagnet, fixture and supporting frame. Experiments were conducted on stainless steel workpieces at different magnetic field strength to observe its effect on final surface finish. No measurable change in surface roughness is observed after finishing at zero magnetic field. However, for the same number of cycles the roughness reduces gradually with the increase of magnetic field. This validates the role of rheological behaviour of magnetorheological polishing fluid in performing finishing action. 

· Sankar, M. Ravi, Jain, V.K. and Kumar, J. Ram [3] developed a rotational abrasive flow finishing set up and calculate the length of helical path generated during finishing process. In  R-AFF process, additional force (tangential force (Ft)) and velocity (tangential velocity  (Vt) ) act on an abrasive grain other than the axial force (Fa), axial velocity (Va) and radial force (Fr) acting in AFF process. The Ft and Vt assist the abrasive particle to shear the workpiece surface peaks more easily. In their study they found that In R-AFF process, additional force (tangential force(Ft)) and velocity (tangential velocity(Vt)) act on an abrasive grain other than the axial force (Fa), axial velocity(Va) and radial force (Fr) acting in AFF process. The Ft and Vt assist the abrasive particle to shear the workpiece surface peaks more easily. Hence, R-AFF process yields better ΔRa (44%) and higher MR (80%) as compared to AFF process in case of Al alloy/SiC (10%) MMC. A mathematical model is developed to calculate helix angle and helical path length in finishing region, which shows a good agreement with the experimental helix angle and helical path length (within82.5%accuracy).The abrasive traverse path in R-AFF process (helical path) is always larger than the AFF process (straight line) in each cycle. As the workpiece rotational speed increases, the experimental helix angle gradually decreases and helical finishing path length steadily increases. As a result, %ΔRa increases with a decrease in helix angle (or increase in RPM). Better ΔRa is achieved in case of Al alloy/SiC (10%) MMC as compared to other two materials .Al alloy is softer material so the abrasive grains make deeper indentation and create their own deeper scratches to give rougher surface .In Al alloy/SiC (15%), the reinforcement agglomeration results in weaker bonding between reinforcement particles. When the abrasive grains try to shear the agglomerated area, the reinforcement pullout occurs leaving a deep valley on the workpiece surface, hence rougher surface is obtained. 
· Sankar, Mamilla Ravi, Jain, V.K., and Kumar, J.Ram. [4] developed rotation abrasive flow finishing process. They found that rotational abrasive flow finishing can produce 44% better surface finish and 81.1% better material removal as compared to AFF. The abrasive traverse path in R-AFF process is approximately helical but in AFF it is straight line, so the number of surface peaks that finish in R-AFF process is more compared to AFF process. Due to rotational motion of workpiece, there exists tangential force (Ft) which assists the existing axial force (Fa) and radial force (Fr) while finishing. So, the resultant force that shears the workpiece surface peaks is higher in R-AFF process compared to AFF process. Hence the material removal and surface finish achieved are higher. So by these results they conclude that the mechanism of material removal and surface finish are different than the AFF. 

· Wani, Amit M., Yadave, Vinod, and Khatri, Atul. [5] developed a simulation for the prediction of surface roughness in magnetic abrasive flow finishing which is a combination of abrasive flow finishing and magnetic abrasive finishing. A finite element model is developed by them to find the magnetic potential distribution in the magnetic abrasive brush formed during finishing action and then it is used to evaluate machining pressure, surface finish and material removal, they derived the following result (1) The simulation results using finite element technique for surface roughness agree better with the experimental data especially for the low magnetic flux density. (2) The machining pressure between the magnetic brush and the workpiece increases considerably with the increases in magnetic flux density. (3) Magnetic field significantly affects both Surface Roughness and Material removal, the slope of the curve indicate that material removal increases more rapidly with magnetic field than the surface roughness.(4) For a given number of cycles, there is a discernible improvement in material removal and surface finish. Fewer cycles are required for removing the same amount of material from the component, if processed in magnetic field. (5) The effect of increase in diameter of magnetic abrasive particle diameter ‘D’ and abrasive grain diameter‘d’ are remarkably large on surface roughness. Infact its higher value may even deteriorate the quality of surface finish. (6) From the results, it can be said that, first magnetic abrasive diameter ‘D’ should be selected, then abrasive grain diameter‘d'. 
· Singh, Sehijpal and Shan, H.S. [6]. developed a set up for a composite process termed magneto abrasive flow machining (MAFM), and the effect of key parameters on the performance of the process has been studied. Relationships are developed between the material removal rate and the percentage improvement in surface roughness of brass components when finish-machined by this process. They also make use of Analysis of variance to identify the significant parameters. 
· Singh, Sehijpal , Shan, H.S. and Kumar, P. [7] studied the results of an experimental study (mixed factorial design) conducted with the objective to understand the mechanism of material removal (MR) and the wear behaviour of some materials when processed by AFM and magnetically assisted abrasive flow machining. Scanning electron microscopy (SEM) has been used to gain insight into the underlying wear pattern on the surfaces of different materials. The results suggest that the magnetic field has a strong effect on the MR in AFM. Furthermore, the nature of work material plays an important role in controlling the MR on the surface. .they done their work on two materials aluminium and brass. They have concluded that the application of magnetic field around the workpiece while being processed by AFM enhances the MR rate for non-ferromagnetic work materials does not appreciably improve surface roughness of aluminum workpieces (2.41% contribution). However, surface roughness is significantly improved for brass workpieces (88.87% contribution). They also found that the magnetic field has a strong interaction with number of cycles in MR results for brass and aluminium and interaction of magnetic field with number of cycles in final Ra results is significant for aluminum but the same interaction is insignificant for brass. The scatter in roughness values on the work surface varies with the number of cycles in the case of MAAFM, particularly during initial cycles. It remains nearly uniform if the workpiece is processed by AFM.

· Jain, V.K. and Adsul, S.G. [8] studied the effects of different process parameters, such as number of cycles, concentration of abrasive, abrasive mesh size and media flow speed, on material removal and surface finish are studied. The dominant process parameter found is concentration of abrasive, followed by abrasive mesh size, number of cycles, and media flow speed. Experiments are performed with brass and aluminium as work materials. During their course of study, different process parameters such as number of cycles, percentage concentration of abrasives by weight, abrasive mesh size, and media flow speed are varied to analyze their effects on material removal and surface roughness. With the help of a multivariable curve-fitting technique, the experimental results are analyzed. The analytical results are compared with the experimental observations. The effect of various process parameters on the surface texture is also studied using scanning electron microscopy. 

· Gorana, V.K., Jain, V.K. and Lal, G.K. [9] developed a theoretical model for forces acting on a single grain in AFM and experimental research has been carried out by measuring the axial force, radial force and active grain density during the AFM process. 
· Jain, Rajendra K., Jain, Vijay K. and Dixit, P.K. [10] studied a model for the flow of AFM media through cylindrical workpiece is developed and solved by finite element method. Model is developed to predict the radial stresses at the workpiece surface with reasonable accuracy. A model for the material removal by the abrasive media is also presented. Classical abrasion theory has been applied in the simulation model. The model is based on accumulated plastic flow, by repeated indentation by moving abrasive particles. The model includes the operating conditions of the process, e.g. abrasive size, number of contacting abrasive particles, extrusion pressure, workpiece material hardness and size of workpiece to be machined. Good agreement was found between the experimental results and theoretical predictions. By this they concluded that, the model, developed for the media flow in AFM predicts the radial stresses at the workpiece surface with reasonable accuracy. The piston velocity increases linearly with piston pressure and its value is higher for larger angle of tool. At higher value of reduction ratio, the rate of increase in piston pressure is higher. The normal stresses on the workpiece surface increase with increase in reduction ratio. Material removal increases with piston pressure and percentage concentration of abrasives in media, but its value decreases with mesh size of abrasive grains. Surface roughness value decreases with increase in piston velocity, piston pressure, percentage concentration of abrasives and grain mesh size for a specified number of cycles. Beyond a certain value of velocity and pressure, it deteriorates due to increase in depth of indentation. The minimum surface roughness value is equal to the critical surface roughness. Although the method has been defined for, and applied to, axisymmetric problems, the technique is easily extendable to three dimensional cases.
· Williams R.E., Rajurkar K.P. [11] developed a  full  factorial experimental  design  to  study  the  effect  of  medium viscosity  and  extrusion  pressure  on  metal  removal and  surface  roughness.  Medium’s viscosity effect is more significant on material removal as compared to extrusion pressure.  It is also reported that major change in the surface finish is observed after finishing for a few cycle only. They also  developed  a  stochastic model  of  AFM  generated  surfaces  by  using  Data Dependent  Systems (DDS)  methodology.  They  have estimated  the  ratio  of  surface  roughness  peak  to valley  height  (R)  to  centreline  average  surface roughness value (R) by DDS methodology and found to be between 1.2 to 2.2 for the AFM process. It was established  in  their  research  that  AFM  finished surface  profiles  possess  two  distinct  wavelengths,  a large wavelength that corresponds to the main path of abrasive  while  the  small  wavelength  is  associated with  the  cutting  edges.  Good  agreement  is  found between  the  primary  frequency  ranges  obtained  in DDS  modeling  and  those  derived  from  spectral analysis  function.  It  is  stated  that  these  frequency bands are related to different material removal modes in  AFM;  consequently,  the  mechanism  of  material removal in  AFM  is considered  to consist  of ploughing responsible for creation of characteristic flow lines and micro-cutting.  They also proposed an expression for estimating the abrasive grain wear and the number of active grains (C).  The  estimated value  of  C is  used as  a  cutting  life  criterion  for  abrasives.  For  small number of  cycles its value  should  remain fairly stable but  with  more  and  more  processing  the  abrasive particles may fracture thereby increasing the C The  downturn  of C value  indicates that  the medium has absorbed too much work piece material and need replacement. 
· Fletcher A.J., Hull J.B, Mackie J., Trengove S.A., [12] studied the relationship between medium rheological properties and the AFM process. Shear rate of the polymer increases when it passes through the restriction (or reduced cross-sectional area). Capillary rheometer is used to find the relationship between wall shear stress and shear rate for medium viscosity of polyborosiloxane medium. They concluded that coefficient of viscosity decreases but shear stress increases as shear rate increases. Variation of wall shear stress with time is also studied. They also concluded that greater finishing action could be achieved as a result of longer piston stroke durations, due to higher wall shear stress generated. 
· Rhoades L.J., [13] investigated the basic principle of AFM process and identified its control parameters.  He  observed  that  when  the medium  is  suddenly  forced  through  restrictive passage  then  its  viscosity  temporarily  rises . Significant material removal is observed only when medium is thickened.  The  amount of abrasion during AFM  depends  on  design  of  tooling,  extrusion pressure, medium viscosity and medium flow volume All these parameters ultimately change the number of  particles interacting with  the  work piece  and the force acting on individual abrasive grain. A higher volume of used in industrial applications such as precision grains with the work piece, hence more abrasion takes place.  Number  of  cycles  depend  on  the  velocity  of medium, during  a  given  time period.  Flow  pattern of  medium  depends  on  its  slug  (medium  exiting the work piece)   flow  speed,  medium  rheology  and passage  size  (cross-sectional  area).  AFM can be used in industrial applications such as precision removal of deburring, edge contouring, surface finish, removal of the thermal recast layer. 
· Sankar, M. Ravi, Jain,V.K. and Kumar, J. Ram [14] AFM is a well established advanced finishing process capable of meeting the diverse finishing requirement from various sectors of applications like aerospace, medical and automobile. It is commonly applied to finish complex shapes for better surface roughness value and tight tolerances. But the major disadvantage of this process is low finishing rate. So continuous efforts are being made to increase finishing rate, improve surface texture and to some extend to improve MRR. To achieve an accurate and efficient finishing operation without compromising the finishing performance, understanding of inter relationship between various input parameters and output responses that influence the process performance. This leads to identification of various optimal finishing conditions from the infinite number of combinations and their modelling. The better performance is achieved if the process is monitored online. So, acoustic emission technique is tried to monitor the surface finish and material removal but ended with only marginal improvement. Later various modelling techniques (mathematical, analytical and empirical) are used to model this process to correlate with experimental results. To overcome the disadvantages of the process, many modifications (MAFM, CFAAFM, DBGAFF, R-AFF and spiral polishing method) have been tried. But in spiral polishing, CFAAFM and DBGAFF processes, the probability of role of additional tooling which is at the middle of the slug has less influence on the finishing direction of active abrasive grain. But later this problem is solved by rotating the workpiece itself. It makes the active abrasive grains to follow helical path, which improves the contact length of the active abrasive grain with workpiece. In R-AFF process, better improvement in surface roughness is achieved compared to AFM and takes lesser time to achieve same surface finish that can be achieved through AFM process. But authors feel that there is still room for lot of improvements in the present AFM status.
2.1 IDENTIFIED GAPS IN THE LITERATURE 

After a comprehensive study of the existing literature, It is seen that:

· Literature review reveals that the researchers have carried out most of the work on AFM, RAFM and MAF but very limited work has been reported on MRAFF.

· Taguchi method is another thrust area which has been given less attention in past studies. 

CASE STUDY                                                                                                                     3
3.1 SELECTION OF PROCESS PARAMETERS
In order to identify the process parameters that may affect the machining characteristics of RMRAFF process, an Ishikawa cause and effect diagram has been constructed and is shown in Figure 3.1.
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Fig 3.1. Ishikawa Cause and Effect Diagram for R-MRAFF Process
3.1.1 Current
Current is represented by I, and it is the amount on current passing thorough the coils of the system to generate magnetic field. The current settings are varied from 1 A to 5 A in steps of one. With the increase in current, magnetic field also increases forming strong chains of CIPs.
3.1.2 Number of cycles
Number of cycles are represented by Ns. Numbers of cycles play an important role in deciding the final volumetric material removal and final surface finish. 

3.1.3 Rotational Speed 

Rotational Speed is represented by ω and it is the speed given to the rams of the system, with the increase in rotational speed centrifugal force acting on the MR polishing particles increases and hence MR polishing particles impinge upon the work surface material with greater resultant force.
3.2   MATHEDOLOGY 1: MAGNETOSTATIC MODELING
     A 3D model of RMRAFF developed in Maxwell student version software. The material for electromagnet coil is copper of relative permeability 1. The assignments of material for the inner core as well as outer core are iron with relative permeability 4000. The work piece material used is of brass with relative permeability 1. The magnetostatic simulation has been done for the developed model using Maxwell software to check the variation of magnetic field generation at the work piece .The variation of magnetic force at the work piece has been studied for the different values of current.
3.2.1 Steps involved in 3D modeling
Specify a Solution Type
The first step is to choose the solution type:

1 
Click Maxwell>Solution Type from the menus.

The Solution Type dialog box appears.

2 
Select Magnetostatic.

3 
Click OK.
Set the Drawing Units
1 
Click 3D Modeler>Units.

The Set Model Units dialog box appears.

2 
Select mm from the Select units pull down menu.

3 
Click OK.

Create the Outer Armature Object
Before creating, make sure that the XY drawing plane is selected and that 3D is selected as the movement mode.
To create the outer cylinder:

1 
Click Draw>Cylinder from the menus.

The cursor changes to a small black box (Drawing mode).

2 
Select the centre of the cylinder by clicking at the (0, 0, 0) location (the origin of the coordinate system).

3 
Enter 104.5 for the radius in the dX box (at the bottom of the screen),

and click Enter.

4 
Enter 25.4 for the height in the dZ box, and click Enter.

The Properties window appears automatically, with the Attribute tab displayed. You can also access the properties window directly from an area in the Maxwell desktop.

5 
Click OK.

6
Change the Name field value (currently Cylinder1) to Outer_arm.

7 
To change the colour of the cylinder to red:

a. Scroll down to the Colour property, and click the Edit button.

The Colour palette window appears.

b. Select one colour, and click

OK to return to the main Properties window.

8 
To set the transparency to (0 to 1), click the button for the Transparent

Property, and enter (0 to 1) in the box, and click OK to close the Set Transparency

dialog box and return to the main Properties window.

9 
Click OK to close the Properties window.

10 
In the history tree window, double-click the Create Cylinder field.

The Properties window appears, with the Command tab displayed.

11 
In this window, you can visualize the geometric data and edit it. Click OK when you are done making any desired edits.
Repeat the procedure above to create another cylinder (named Cylinder_tool) with the same center and height as Outer_arm but with a radius of 83.1 mm. Next, subtract Cylinder_tool from Outer_arm.
To subtract the second cylinder from the first:

1 
Select both cylinders by clicking their names in the history tree (hold the Ctrl key down when selecting the second one).

2 
Click 3D Modeler>Boolean>Subtract.

3 
If necessary, move the Outer_arm object into the Blank Parts column and the Cylinder_tool object into the Tool Parts column, by selecting each object and using the arrows to move it.

4 
Click OK.

Add the two magnetic poles to the outer armature. First create a box, then move the box into the correct position, and use the Mirror command to create a duplicate of the box. Unite the three model objects, and subtract the center to arrive at the final shape.
To create a box:

1 
Select Box from the Draw menu.

2 
Enter the box position (-13.0, 0, 0) in the X, Y, and Z fields at the bottom of the screen, and then press Enter.

3 
Enter the box size (27.8, -40, and 25.4) in the dX, dY, dZ fields, and then press Enter.

The Properties window appears.

4 
Click OK.
To move the box into position:

1 
Select the box object previously created.

2 
Select Edit>Arrange>Move.

3 
Enter (0, 0, 0) in the (X, Y, Z) fields as the origin of the move vector, and press Enter.

4 
Enter (0, -45, 0) in the (dX, dY, dZ) fields as the target point of the move vector, and press Enter.
To create a duplicate of the box using mirroring:

1 
Select the box previously created.

2 
Select Edit>Duplicate>Mirror.

3 
Enter (0, 0, 0) in the (X, Y, Z) fields as coordinates for the anchor point on the mirror plane and press Enter.

4 
Enter (0, 1, 0) in the (dX, dY, dZ) fields as coordinates of target point of the vector normal to the mirror plane and press Enter.
To unite the three objects in the model:

1 
Select the three objects in the model from the history tree window

(select Outer_arm first, then hold down the Ctrl key and select the boxes).

2 
Select 3D Modeler>Boolean>Unite.

Because the first selected object was Outer_arm, the final object name assigned by default is Outer_arm. The name of the objects can be easily changed if desired in the Properties window with the Attribute tab selected.
To provide the final shape for the magnetic pole faces:

1 
Create a cylinder with the center at (0, 0,0), a radius of 53.75, and a height of 25.4.

2 
Select the Outer_arm object, then hold down the Ctrl key and select the cylinder.

3 
Select 3D Modeler>Boolean>Subtract.

The Subtract dialog box appears.

4 
Make sure the Outer_arm object is in the Blank Parts column and the Cylinder1 object is in the Tool Parts column.

5 
Click OK.

Create the Coils
First create a new coordinate system (CS1) such that in the new coordinate system the   XY plane becomes a median plane of the model.
To create the new coordinate system:

1 
Select Coordinate System>Create>Relative CS>Offset from the 3D Modeler menu.

2 
Enter the new origin (0, 0, 12.7) in the (X, Y, Z) boxes, and then press Enter.

The coil(s) are created by sweeping the coil cross-section along a path.
Do the following to create the path, the cross-section, and the coil:

1 
Set drawing plane to XZ.

2 
Select Rectangle from the Draw menu.

3 
Enter (-17, 0 -15.5) in the (X, Y, Z) boxes, for the rectangle position, and then press Enter.

4 
Enter (34, 0, 31) in the (dX, dY, dZ) boxes, and press Enter.

5 
Select the Edit>Select>Faces, and select the newly created rectangle by clicking on it in the 3D Modeler window.

6 
Select 3D Modeler>Surface>Uncover Faces.

7 
Change the name of the uncovered entity to path.

8 
Set the drawing plane to YZ.

9 
Select Rectangle from the Draw menu to draw the cross-section of the coil.

10 
Enter (0, 0, 15.5) in the (X, Y, Z) boxes, for the rectangle position, and then press

Enter.

11 
Enter (0, 17, 24) in the (dX, dY, dZ) boxes, and press Enter.

12
Change the name of the newly created rectangle to coil1.

13 
Select the path and the cross-section by selecting their names in the history tree window (hold down the Ctrl key for the second selection).

14 
Select Sweep>Along Path from the Draw menu, and click OK to accept the defaults.

15 
Click OK to create the coil
The final coil shape has rounded outside corners.

Using the new coordinate system CS1, do the following to achieve the final shape:

1 
Create a cylinder at the origin with a radius of 43 mm and a height of 17 mm.

2 
Select the cylinder and the coil, and perform a Boolean intersection.
Move the coil in the final position:

1 
Select the coil by clicking its name in the history tree window.

2 
Select Arrange>Move from the Edit menu.

3 
Specify (0, 0, 0) in the (X, Y, Z) fields, for the origin of the move vector, and then press Enter.

4 
Specify (0, 54.5, 0) in the (dX, dY, dZ) fields as the target point of the move vector, and press Enter.
Create a mirror duplicate of the coil:
1 
Select the coil by clicking its name in the history tree window.

2 
Select Arrange>Move from the Edit menu.

3 
Specify (0, 0, 0) in the (X, Y, Z) fields as the coordinates of the anchor point on the mirror plane, and then press Enter.

4      Specify (0, 1, 0) in the (dX, dY, dZ) fields as coordinates of target point of the vector normal to the mirror plane, and press Enter.
Create the Coil Terminals

To create the terminals for the coils:
1       Select the two coils by clicking their names in the history tree window.

2      Select Surface>Section from the 3D Modeler menu, specify XY as the section plane, and click OK.

3      Select Boolean>Separate Bodies from the 3D Modeler menu. This allows the separation of the inter-linked sheet objects created since the intersection of the XY plane with either coil created two terminals in each coil.

4        Select the two redundant terminals, one at a time (click each name in the history tree window), and then press the Delete key on the keyboard.
Creating RMRAFF model

 Create upper outer cylinder by first taking cylinder from the draw command.
1. Enter (0, 0, 35) in the (X, Y, Z) boxes, for the cylinder position, and then press Enter.
2. Now enter (35, 35,175) in (dX, dY, dZ), this will create a cylinder.
3. Now create one more cylinder with the above method with (34,35,175) in (dx,dY,dZ)
4. Use substract command and substract cylinder 2 from cylinder 3 in the same manner   as done above for making the coil assembly.
5. Now create a plate type fixture with radius = 40mmfor holding the work piece and attach it to the upper cylinder.
6. For lower cylinder use mirror command and by putting (0,0,0) in (X,Y,Z) and (0,0,-1)
            in (dX,dY,dZ) this will form exactly same cylinder as used for upper cylinder.

7. Now create Rams for the system, for this make two cylindrical thick plates and attaché a rod to it at upper side for its vertical and rotational motion.

8. Now makes a Rod which joins the two rams together.

9. Now create media cylinder for both lower and upper cylinders by using cylinder command with radius =33mm and length of stroke=105mm

10. Now make a work piece of cylindrical hollow shape, for this first create a cylinder with (0,0,0) in (X,Y,Z) and then (37,0,35) in (dX,dY,dZ).

11. Now make another cylinder with (0,0,0) as center and (35,0,35) in (dX,dY,dZ)

12. Now use subtract command, and subtract 2nd cylinder from 1st this will make a hollow cylindrical shape of the workpiece with 35mm as its height.

13. Once the whole geometry is done, assign the material for each component. For this open the history tree click on the object and a property window will open ,on it select attribute tab and then select material for that object ,this is shown in the below figure.
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Fig.3.2 image showing, assignment of material to objects.
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Fig.3.3 image showing different materials Analysis

Assign Excitations
Currents need to be defined and assigned as excitations for the two coils terminals.
To define the currents:

1 
Select each terminal (one at a time) by clicking it in the history tree window.

2 
Right-click, and select Assign Excitation>Current from the shortcut menu.

3 
Enter Current A in the value box and select Stranded as the type.

4 
Click OK to validate the excitation and close the window.

5 
Repeat steps 1-4 for the second terminal.

By default, all faces of the region box (background) are assigned with magnetic flux tangent boundary conditions. Therefore, no additional boundary conditions are required for this MRAFF model problem.
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Fig.3.4 image showing, assignment of current

Set Up Parameter Calculations
In this model, we will calculate the magnetic force parameters.
To set up the magnetic force calculation:

1  
Select the workpiece object by clicking its name in the history tree window.

2 
In the Project Manager window, right-click the Parameters row, and then select Assign>Force

3
Leave the type set to Virtual.

4 
Select as the torque calculation Global:Z from the Axis pull-down list.

5 
Select the Positive orientation radio button for the axis.

6 
Click OK.

Set up the Analysis
To set up the analysis:

1 
Right-click the Analysis field in the Project Management window.

A shortcut menu appears.

2 
Select Add Solution Setup.

3 
Accept the defaults.

4 
Select the previously set up Force calculation from the Display Force in Convergence pull-down list.

5 
Click OK.
Running the Analysis
To run the analysis:

1 
Right-click the Analysis field in the Project Management window.

A shortcut menu appears.

2 
Select Analyze.

3 
To visualize the progress of the solution, right-click the Setup1 field (located under the Analysis field), and select Convergence. Make sure the Convergence tab is selected, and select a tabular or graphical format for how to visualize the information about the energy, number of finite elements, torque, etc.

4 
When the solution is complete, extract the value of the magnetic force.

Plot the Magnetic Flux Density Vector
Let us plot the flux density vector on the mid vertical symmetry plane of the device. If you followed the instructions as described above, you should already have a relative coordinate system (CS1) containing the desired plot plane as a coordinate system plane. In preparation for the plot we need to create a list of objects since we want the respective results plotted

in the two armatures only.

1 
Select (by clicking in the history tree window) the Outer_arm and Workpiece and MR fluid objects.

2 
Select List>Create>Object List from the 3D Modeler menu

The list of selected objects (Objectlist1) is added under the Lists in the history tree window.

To perform the plot, follow these steps:

1 
Select the RelativeCS1:XY plane under Planes in the history tree window.

2 
Right-click Field Overlays in the project management window, and select Fields>B>B_Vector.

3 
Make sure the Quantity is B_Vector.

4 
In the Volume column click Objectlist1.

5 
Click Done.

6 
Double-click the legend.

7 
Click the Scale, Marker>Arrow, or Plots tabs if you need to change the scale, the size or spacing of the arrows.
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Fig.3.5(a) image showing variation in magnetic field.
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Fig.3.5(b) image showing variation of magnetic field line variation at MR fluid region area
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Fig.3.6 image showing magnetic field acting on the workpiece area.

3.3 MATHEDOLOGY 2: MATHEMATICAL MODELING.

3.3.1 Mathematical Modeling for forces.

     The forces acting on an abrasive particle when it is approaching a roughness peak are magnetic force (Fm) transferred by the surrounding CIPs, which helps in indenting the abrasive particle into the work piece surface. Shear force due to the pressure applied by the hydraulic unit helps in removing the roughness peak, and resistance force (Fr) exerted by the work piece against the material removal and a centrifugal force (Fc) generated by the rotation of ram.
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Fig.3.7 basic model setup used and different forces in finishing region.

Where [image: image19.png]Fa
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 and α is the semi cross hatch angle.
Resultant of axial and indentation force is given as (Fig.3.7)
[image: image41.png]Ff =\Fa® + Fm+Fo)?.



                                                                        (3.3.1)                  

And the other component of force the tangential when we apply rotation to the rams will also contribute in the resultant force, so the final force acting on a CIP abrasive particle is given as:

          [image: image43.png]Frf=FfZ+Ft? = \[Fa? + (Fm + Fc)? + Ft?



 .                                      (3.3.2)                   

Due to rotation of rams in the working process, two extra components of forces called centrifugal force and tangential force produced, which will help in removing more metal from the work piece.

Resistance offered by the work piece for removal of material in the form of chips is given by:

[image: image45.png]Freq= tsXAp.



                                                                                            (3.3.3)              

Where, ts is shear strength of work piece material and Ap is the projected area of penetration.

Three conditions arise 

If [image: image47.png]JFaZ + (Fm + Fc)? + Ft?



 > Freq, then material will get removed.                      (3.3.4)

If [image: image49.png]JFaZ + (Fm+Fc)? + Ft?



< Freq, then there will be no material removal           (3.3.5)

If[image: image51.png]JFaZ + (Fm+Fc)? + Ft?



 = Freq, material removal initiates                               (3.3.6)              

3.3.2 Determination of forces
To get an insight into the reasons for variation in reduction in surface roughness (ΔRa) and volumetric material removalwith different combinations of process parameters, it is required to develop a mathematical model to predict the forces acting on abrasive particles during R-MRAFF process. Following assumptions were made to simplify the analysis and to understand the process:

1. The SiC particles embedded in the carbonyl iron chains are assumed to repeat and span from one end to another end of the fixture. This assumption is made to simplify the physical model, though in actual case the chain like structures formed between the magnetic poles are more complex . Iron chains many times terminate at the abrasive particles that come in their way and form clusters by aggregating into cylindrical columns.

2. All abrasive particles are assumed spherical of average diameter, calculated from their mesh size number. In practice, no two abrasive particles resemble each other in shape and size.

3. The abrasive particles are assumed uniformly distributed in MR-fluid. 

4. It is assumed that a spherical abrasive particle penetrates into the work piece surface under the action of the normal component of magnetic force on carbonyl iron particles in the presence of magnetic field and component of centrifugal force due to rotation of rams of the system.

5. The MRP-fluid structure assumed at rest is field elongated chains of particles agglomerates. The effect of fringing field at the corners of the magnetic pole piece is neglected because of the bigger size of pole piece than the work piece length.

6. The magnetic force on iron particles in a stationary system (no shearing applied), on the application of magnetic field, shows steady rise with time after an initial jump. This normal force decreases with strain and reaches plateau value at large strains. In calculating normal indentationforce this decrease is not considered and the normal force is assumed constant, which results in comparatively higher indentation.

Radial force (Fra) 

  [image: image53.png]oxmx (%)
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.                                                                                                  (3.3.7)              

Where Di  is the diameter of the projected area (figure.3.8a) and [image: image54.png]


 flow stress of the material.

Axial force (Fa) 

It is a combination of ploughing force and resistance force.
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         (3.3.8)

Where Dg is the diameter of the abrasive particle and [image: image58.png]


 is the coefficient of friction.

Centrifugal force (Fc) 

Mass of the particle can be calculated as

        [image: image60.png]


 =4∕3[image: image62.png]


×ρ.                                                                                                    (3.3.9)
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1.                                                                                                   (3.3.10)
Where r is the radius of the abrasive grain.

Magnetic force (Fm) 
           Fm=[image: image66.png](MX...B Zf) =



.                                                                                      (3.3.11)

Where [image: image68.png]Xm



 is mass susceptibility of CIP[image: image70.png](m?/]
kg



), B is magnetic field density (T), μo is permeability in free space (4[image: image72.png]


×[image: image74.png]1077



Wb/A m). Mass of a CIP is calculated by considering spherical shape of the CIP.

3.3.3 Modeling for surface roughness and volumetric material removal.

    The Brinell hardness number (BHN) can be correlated to the depth of indentation in the in the work piece as follows:

          [image: image76.png](Fm+Fc)
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 .                                                                        (3.3.12)
Where [image: image78.png](Fm + Fc)



 is the indentation force on the work piece surface, Di is indentation diameter and Dg is the diameter of abrasive particle (19 mm). Hardness of Brass workpiece is measured from Viker’s micro-hardness testing  and is found to be equal to 90 BHN. Indentation diameter (Di) is calculated by substituting hardness value of the workpiece in BHN and indentation force, ([image: image80.png]Fm + Fc)



, into Eq. (3.3.12). From the geometry of the Fig. 3.8 (a), depth of indentation (t) can be calculated as:
                          t=[image: image82.png]
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 .                                                                                 (3.3.13)
The cross-sectional area A’ of the groove generated (shaded portion of the grain) is derive

 from the following equation.
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.                                               (3.3.14)                                        

The initial surface profile of the work piece is assumed to be triangular as shown in Fig.3.8. It is assumed that initial surface profile of the work piece is uniformly distributed with initial surface roughness [image: image90.png]


and abrasives move perpendicular to the direction of the scratches.   
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Fig.3.8 (a) Schematic diagram of the indentation of a spherical abrasive grain on the work piece surface, (b) shape of the peak of the irregularity machined.

Volume of material removed (Vg) by an abrasive grain is obtained as:

           Vg=A’[image: image94.png](1—% Iw



.                                                                                         (3.3.15)
                                                                                                                                              Where [image: image95.png]


 is the total length of the work piece [image: image97.png]


is the surface roughness after ith cycle. As the total material removal is made up of number of similar cycles, total number of abrasive grains (ns) indenting into the work piece surface per stroke is given by:

            ns=2[image: image99.png]
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.                                                                                           (3.3.16)         

Where ls is the stroke length of the piston, rc [image: image103.png]


is the radius of the medium cylinder, rf is the radius of the work piece fixture.

From geometry figure 3.8 (b) volumetric material removal (Mv) in ith stroke is given by:

            Mv=[image: image105.png](Fa-Ra) 2



.                                                                                             (3.3.17)
As, Mv in ith stroke= (Vg) ×ns,  it is given as

                                                                                                                                                                                                                        Mv= 2[image: image107.png]
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.  (3.3.18)
Comparing above two equations (3.3.17) and (3.3.18), final roughness value can be calculated as
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(3.3.19)
So, final equation for surface roughness value is
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 (3.3.20)
And for Volumetric material removal it is,

            Mv=[image: image119.png](Fa-Ra) 2



                                                                                              (3.3.21)
Values of the constants of Eq. (3.3.20) are ls=105mm, lw=35mm, rf=40mm, rc=33mm. Surface roughness for ith cycle is calculated from Eq. (3.3.20) for different supply currents (1, 2, 3, 4, and 5) through the electromagnet after substituting the above-mentioned values of the constants into Eq. (3.3.20). Output of surface roughness obtained after each cycle is used as initial value of surface roughness (i.e. input) for estimation of surface roughness during next cycle. The initial roughness value for brass used is 1.5 µm.
3.4 MATHEDOLOGY 3: DESIGN OF EXPERIMENT
3.4.1 Design of Experiment
The objective of this research work is to study Surface properties such as Volumetric Material removal and reduction in roughness value. 
 The design variables used can be summarized as follows:

a) Five levels of the current have been used.

b) Five levels of number of cycles have been used.

c) Five levels of rotational speed have been used.

For study, it has been decided to follow the Taguchi method of experimental design and an appropriate orthogonal array is to be selected after taking into consideration the above design variables. Out of the above listed design variables, the orthogonal array was to be selected for three design variables (namely current, number of cycles and rotational speed) which would constitute the orthogonal array.
The two most important outputs are volumetric removal rate and reduction in roughness value has been selected as response parameters for this thesis work. The effect of the variation in input process parameter will be studied on these two response parameters and the data will be analyzed as per Taguchi method to find out the optimum machining condition.
3.4.2 TAGUCHI’S DESIGN AND ANALYSIS
3.4.2.1 Taguchi’s philosophy
Taguchi's comprehensive system of quality engineering is one of the greatest engineering achievements of the 20th century. His methods focus on the effective application of engineering strategies rather than advanced statistical techniques. It includes both upstream and shop-floor quality engineering. Upstream methods efficiently use small-scale experiments to reduce variability and remain cost-effective, and robust designs for large-scale production and market place. Shop-floor techniques provide cost-based, real time methods for monitoring and maintaining quality in production. The farther upstream a quality method is applied, the greater leverages it produces on the improvement, and the more it reduces the cost and time. Taguchi’s philosophy is founded on the following three very simple and fundamental concepts [15, 16].
· Quality should be designed into the product and not inspected into it. 

· Quality is best achieved by minimizing the deviations from the target. The product or process should be so designed that it is immune to uncontrollable environmental variables. 

· The cost of quality should be measured as a function of deviation from the standard and the losses should be measured system-wide. 

Taguchi proposes an “off-line” strategy for quality improvement as an alternative to an attempt to inspect quality into a product on the production line. He observes that poor quality cannot be improved by the process of inspection, screening and salvaging. No amount of inspection can put quality back into the product. Taguchi recommends a three-stage process: system design, parameter design and tolerance design [15, 16]. In the present work Taguchi’s parameter design approach is used to study the effect of process parameters on the various responses of the RMRAFF process.
3.4.2.2 Design strategy
Taguchi recommends orthogonal array (OA) for laying out of experiments. These OA‟s are generalized Graeco-Latin squares. To design an experiment is to select the most suitable OA and to assign the parameters and interactions of interest to the appropriate columns. The use of linear graphs and triangular tables suggested by Taguchi makes the assignment of parameters simple. The array forces all experimenters to design almost identical experiments [15]. In the Taguchi method the results of the experiments are analyzed to achieve one or more of the following objectives [15]: 

· To establish the best or the optimum condition for a product or process 

· To estimate the contribution of individual parameters and interactions 

· To estimate the response under the optimum condition 

The optimum condition is identified by studying the main effects of each of the parameters. The main effects indicate the general trends of influence of each parameter. The knowledge of contribution of individual parameters is a key in deciding the nature of control to be established on a production process. The analysis of variance (ANOVA) is the statistical treatment most commonly applied to the results of the experiments in determining the percent contribution of each parameter against a stated level of confidence. Study of ANOVA table for a given analysis helps to determine which of the parameters need control [15]. 

Taguchi suggests two different routes to carry out the complete analysis. First, the standard approach, where the results of a single run or the average of repetitive runs are processed through main effect and ANOVA analysis (Raw data analysis). The second approach which Taguchi strongly recommends for multiple runs is to use signal- to- noise ratio (S/N) for the same steps in the analysis. The S/N ratio is a concurrent quality metric linked to the loss function. By maximizing the S/N ratio, the loss associated can be minimized. The S/N ratio determines the most robust set of operating conditions from variation within the results. The S/N ratio is treated as a response (transform of raw data) of the experiment. Taguchi recommends [16] the use of outer OA to force the noise variation into the experiment i.e. the noise is intentionally introduced into experiment. However, processes are often times subject to many noise factors that in combination, strongly influence the variation of the response. For extremely “noisy” systems, it is not generally necessary to identify specific noise factors and to deliberately control them during experimentation. It is sufficient to generate repetitions at each experimental condition of the controllable parameters and analyze them using an appropriate S/N ratio. In the present investigation, the raw data analysis and S/N data analysis have been performed. The effects of the selected RMRAFF process parameters on the selected quality characteristics have been investigated through the plots of the main effects based on raw data. The optimum condition for each of the quality characteristics has been established through S/N data analysis aided by the raw data analysis. No outer array has been used and instead, experiments have been repeated three times at each experimental condition.
3.4.2.3 Loss function
The heart of Taguchi method is his definition of the nebulous and elusive term “quality” as the characteristic that avoids loss to the society from the time the product is shipped. Loss is measured in terms of monetary units and is related to quantifiable product characteristic. Taguchi defines quality loss via his “loss function”. He unites the financial loss with the functional specification through a quadratic relationship that comes from a Taylor series expansion. The quadratic function takes the form of a parabola. Taguchi defines the loss function as a quantity proportional to the deviation from the nominal quality characteristic. He has found the following quadratic form to be a useful workable function [15]:
                    L(y) =k(y-m) 2                                                                                           (3.4.1)
             Where, 

                          L = Loss in monetary units

                         m = value at which the characteristic should be set

                         y = actual value of the characteristic

                           k = constant depending on the magnitude of the characteristic and the monetary unit involved.

                                    [image: image120.emf]
Fig. 3.9 graphical representation of loss function.

The loss function represented in Eq. 3.4.1 is graphically shown in Figure 3.9.

 The characteristics of the loss function are [15]: 

· The farther the product’s characteristic varies from the target value, the greater is the loss. The loss must be zero when the quality characteristic of a product meets its target value. 

· The loss is a continuous function and not a sudden step as in the case of traditional (goal post) approach. This consequence of the continuous loss function illustrates the point that merely making a product within the specification limits does not necessarily mean that product is of good quality. 
3.4.2.4 Signal to noise ratio
The loss-function discussed above is an effective figure of merit for making engineering design decisions. However, to establish an appropriate loss-function with its k value to use as a figure of merit is not always cost-effective and easy. Recognizing the dilemma, Taguchi created a transform function for the loss-function which is named as signal -to-noise (S/N) ratio. 

The S/N ratio, as stated earlier, is a concurrent statistic. A concurrent statistic is able to look at two characteristics of a distribution and roll these characteristics into a single number or figure of merit. The S/N ratio combines both the parameters (the mean level of the quality characteristic and variance around this mean) into a single metric. 

A high value of S/N implies that signal is much higher than the random effects of noise factors. Process operation consistent with highest S/N always yields optimum quality with minimum variation. 

The S/N ratio consolidates several repetitions (at least two data points are required) into one value. The equation for calculating S/N ratios for „smaller is better‟ (LB), „larger is better‟ (HB) types of characteristics are as follows [16].
1. Larger the Better: 
(S/N)HB= - 10 log (MSDHB)                                                                                        (3.4.2)
Where,
MSDHB   =  [image: image122.png]


                                                                                          (3.4.3)
2. Smaller the Better: 
(S/N)LB= - 10 log (MSDLB)                                                                                         (3.4.3)
Where,
MSDLB   =  [image: image124.png]v

)



                                                                                              (3.4.4)
3.4.2.5 Relation between S/N ratio and loss function
Figure 3.10 a shows a single sided quadratic loss function with minimum loss at the zero value of the desired characteristic. As the value of y increases, the loss grows. Since, loss is to be minimized the target in this situation for y is zero. 
[image: image125.emf]
Fig.3.10 (a, b) Taguchi loss function for HB and LB characteristic.

The basic loss function is: 
L(y) = k (y-m)2                                                                                                                                                (3.4.5)
If m = 0                                                                                                                        (3.4.6)

L(y) = k (y2)                                                                                                                (3.4.7)

The loss may be generalized by using k=1 and the expected value of loss may be found by summing all the losses for a population and dividing by the number of samples R taken from this population. This in turn gives the following expression. 
EL = Expected loss = (Σy2/R)                                                                                    (3.4.8)

The above expression is a figure of demerit. The negative of this demerit expression produces a positive quality function. This is the thought process that goes into the creation of S/N ratio from the basic quadratic loss function. Taguchi adds the final touch to this transformed loss-function by taking the log (base 10) of the negative expected loss and then he multiplies by 10 to put the metric into the decibel terminology. The final expression for “smaller-is-better” S/N ratio takes the form of Equation. The same thought pattern follows in creation of other S/N ratios.

3.4.3 selection of orthogonal array and parameter assignment
In this thesis work, there are three parameters at five levels each. The degree of freedom (DOF) of a five level parameter is 4 (number of levels-1); hence total DOF for the experiment is 12. The DOF of the orthogonal array selected should have higher than that of total DOF of the experiment.
	Factors
	Parameters
	Levels

	
	
	L1
	L2
	L3
	L4
	L5

	A

B

C
	Current

No. Of cycles

Rotational Speed
	1

2

2
	2

4

4
	3

6

6
	4

8

8
	5

10

10


Table 3.1  process parameters as per level
Sum of all DOF is 12. So we will take L25 orthogonal array
	Sino
	Current
	Number of cycles
	Rotational Speed

	1
	1
	1
	1

	2
	1
	2
	2

	3
	1
	3
	3

	4
	1
	4
	4

	5
	1
	5
	5

	6
	2
	1
	2

	7
	2
	2
	3

	8
	2
	3
	4

	9
	2
	4
	5

	10
	2
	5
	1

	11
	3
	1
	3

	12
	3
	2
	4

	13
	3
	3
	5

	14
	3
	4
	1

	15
	3
	5
	2

	16
	4
	1
	4

	17
	4
	2
	5

	18
	4
	3
	1

	19
	4
	4
	2

	20
	4
	5
	3

	21
	5
	1
	5

	22
	5
	2
	1

	23
	5
	3
	2

	24
	5
	4
	3

	25
	5
	5
	4


Table 3.2 Standards L25 Orthogonal Array (Taguchi Design)

3.4.4 Data analysis
A number of methods have been suggested by Taguchi for analyzing the data: observation method, ranking method, column effect method, ANOVA, S/N ANOVA, plot of average response curves, interaction graphs etc. 
3.4.5 ANOVA (Analysis of Variance)
The purpose of the statistical analysis of variance (ANOVA) is to investigate which design parameter significantly affects the material removal rate and hardness. Based on the ANOVA, the relative importance of the machining parameters with respect to material removal rate and hardness is investigated to determine more accurately the optimum combination of the machining parameters.

Two types of variations are present in experimental data:
1. within treatment variability

2. Observation to observation variability
So ANOVA helps us to compare variabilities within the data. In present thesis work ANOVA Table is made with help of DESIGN-EASE software. When performance varies one determines the average loss by statistically averaging the quadratic loss. The average loss is proportional to the mean squared error of Y about its target T. The initial techniques of the analysis of variance were developed by the statistician and geneticist R. A. Fisher in the 1920s and 1930s, and are sometimes known as Fisher's ANOVA or Fisher's analysis of variance, due to the use of Fisher's F-distribution as part of the test of statistical significance. Various formulas for ANNOVA:
3.4.6 Taguchi design method

The present section gives the application of the Taguchi experimental design method to investigate the effect of process parameters on the output parameters e.g. volumetric material removal and reduction in surface roughness. The results of the study are discussed subsequently in the following sections.
For the present work three process parameters each at five levels has been decided. The levels of the individual process parameters/factors are given in Table.

	Factors
	Parameters
	Levels

	
	
	L1
	L2
	L3
	L4
	L5

	A

B

C
	Current

No. Of cycles

Rotational Speed
	1

2

2
	2

4

4
	3

6

6
	4

8

8
	5

10

10


Table 3.3 process parameters and levels

After deciding parameters and levels as shown above orthogonal array L25 has been   selected as per degree of freedom of each factor. Data of parameter was collected as per consultant with experience researchers. Results of the process has been calculated from the three dimensional model of the rotational-rheological abrasive flow finishing process(R-MRAFF). Analysis of the results has been carried out analytically as well as graphically. 
Graphical analysis has been done by MINITAB statistical software, shows graphical representation of all parameters. ANOVA of the data has also been done to calculate the contribution of each factor in each response, by using them optimal conditions has been calculated for VMR and reduction in roughness value. The following table shows results of VMR and reduction in roughness value (ΔRa) at each level.
	Sino.
	I(A)
	N
	[image: image127.png]


(rpm)
	Mv(mm3)
	Ravalue   (µm)
	 ΔRa value (µm)

	1
	1
	2
	2
	0.0000007
	1.4991
	0.0009

	2
	1
	4
	4
	0.0000026
	1.4973
	0.0018

	3
	1
	6
	6
	0.0000060
	1.4946
	0.0027

	4
	1
	8
	8
	0.0000125
	1.4907
	0.0039

	5
	1
	10
	10
	0.0000214
	1.4856
	0.0051

	6
	2
	2
	4
	0.0000009
	1.4846
	0.0031

	7
	2
	4
	6
	0.0000036
	1.4825
	0.0021

	8
	2
	6
	8
	0.0000096
	1.4791
	0.0034

	9
	2
	8
	10
	0.0000183
	1.4744
	0.0047

	10
	2
	10
	2
	0.0000216
	1.4693
	0.0051

	11
	3
	2
	6
	0.0000061
	1.4680
	0.0013

	12
	3
	4
	8
	0.0000016
	1.4666
	0.0014

	13
	3
	6
	10
	0.0000140
	1.4625
	0.0041

	14
	3
	8
	2
	0.0000253
	1.4575
	0.0050

	15
	3
	10
	4
	0.0000538
	1.4511
	0.0064

	16
	4
	2
	8
	0.0000194
	1.4495
	0.0016

	17
	4
	4
	10
	0.0000087
	1.4463
	0.0032

	18
	4
	6
	2
	0.0000172
	1.4418
	0.0045

	19
	4
	8
	4
	0.0000327
	1.4356
	0.0062

	20
	4
	10
	6
	0.0000631
	1.4270
	0.0086

	21
	5
	2
	10
	0.0000031
	1.4251
	0.0019

	22
	5
	4
	2
	0.0000118
	1.4214
	0.0037

	23
	5
	6
	4
	0.0000261
	1.4159
	0.0055

	24
	5
	8
	6
	0.0000473
	1.4085
	0.0074

	25
	5
	10
	8
	0.0000768
	1.3991
	0.0094


Table 3.4 and 3.5(below) Results for Mv and Reduction in surface roughness
	S.no
	 S/N ration for Mv (dB) 
	 S/N ratio for ΔRa(dB)

	1
	-123.098
	-60.9151

	2
	-111.700
	-54.8945

	3
	-104.437
	-51.3727

	4
	-98.062
	-48.1787

	5
	-93.392
	-45.8486

	6
	-120.915
	-50.1728

	7
	-108.874
	-53.5556

	8
	-100.355
	-49.3704

	9
	-94.751
	-46.5580

	     10
	-93.751
	-45.8486

	11
	-104.293
	-57.7211

	12
	-115.918
	-57.0774

	13
	-97.077
	-47.7443

	14
	-91.938
	-46.0206

	15
	-85.384
	-43.8764

	16
	-94.244
	-55.9176

	17
	-101.210
	-49.8970

	18
	-95.289
	-46.9357

	19
	-89.709
	-44.1522

	20
	-83.999
	-41.3100

	21
	-110.173
	-54.4249

	22
	-98.562
	-48.6360

	23
	-91.667
	-45.1927

	24
	-86.503
	-42.6154

	25
	-82.293
	-40.5374


3.4.7 Effect on volumetric material removal
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Fig. 3.11 main effect plots for mean of VMR.
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Fig. 3.12 S/N plots for VMR.
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Fig. 3.13 Normal probability plot of the residuals.
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Fig 3.14 variation of residual with observation order
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Fig.3.15 Histogram for residual.
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Fig. 3.16 Residual with Fitted value.

Table 3.6 Response table for Signal to Noise ratio
	Level
	Current 
	Number of cycles
	Rotational Speed

	1
	-106.222
	-110.646
	-100.545

	2
	-103.635
	-107.184
	-99.849

	3
	-98.883
	-97.789
	-97.623

	4
	-92.902
	-92.196
	-98.144

	5
	-93.846
	-87.676
	-99.328

	Delta
	13.321
	22.969
	2.923

	Rank
	2
	1
	3


	Level
	Current 
	Number of cycles
	Rotational Speed

	1
	0.0000086
	0.0000060
	0.0000153

	2
	0.0000108
	0.0000057
	0.0000232

	3
	0.0000202
	0.0000146
	0.0000252

	4
	0.0000282
	0.0000272
	0.0000240

	5
	0.0000330
	0.0000473
	0.0000131

	Delta
	0.0000244
	0.0000477
	0.0000121

	Rank
	2
	1
	3


Table 3.7 Response table for Means

	Source
	Sum of Squares
	dof
	Mean Square
	F value
	P value

	Model
	9.014e-009
	12
	7.512E-010
	9.83
	0.0002

	Current
	2.253E-009
	4
	5.633E-010
	7.38
	0.0031

	Number of cycles
	6.147E-009
	4
	1.535E-009
	20.12
	0.0001

	Rotational Speed
	6.141E-019
	4
	1.535E-010
	2.01
	0.01571

	Residual
	9.166E-010
	12
	7.638E-011
	
	

	Cor. Total
	9.931E-009
	24
	
	
	

	The model value 9.83 implies the model is significant 


Table 3.8 Anova Table for VMR data

3.4.8 Effect on reduction in surface roughness value
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Fig. 3.17 Main effect plots for Means(reduction in roughness value).
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Fig. 3.18 S/N ratio plots for reduction in roughness.
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Fig. 3.19 Normal probability plot for residuals
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Fig. 3.20 Residual with observation values.
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Fig. 3.21 Histogram for Residual.
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Fig. 3.22 Residual with fitted values.

Table 3.9 Response table for S/N value
	Level
	Current 
	Number of cycles
	Rotational Speed

	1
	-52.2419
	-55.8303
	-49.6712

	2
	-49.1011
	-52.8121
	-47.6577

	3
	-50.4880
	-48.1232
	-49.3150

	4
	-47.6425
	-45.5050
	-50.2163

	5
	-46.2113
	-43.4852
	-48.8946

	Delta
	5.9607
	12.3461
	2.5586

	Rank
	2
	1
	3


	Level
	Current 
	Number of cycles
	Rotational Speed

	1
	0.00288
	0.00176
	0.00384

	2
	0.00368
	0.00244
	0.00460

	3
	0.00364
	0.00404
	0.00442

	4
	0.00482
	0.00544
	0.00394

	5
	0.00558
	0.00692
	0.00380

	Delta
	0.00270
	0.00516
	0.00080

	Rank
	2
	1
	3


3.10 Response table for means
	Source
	Sum of Squares
	dof
	Mean Square
	F value
	P value

	Model
	1.155E-004
	12
	9.624E-006
	12.93
	0.0001

	Current
	2.292E-005
	4
	5.729E-005
	7.70
	0.0026

	Number of cycles
	8.990E-005
	4
	2.248E-005
	30.20
	0.0001

	Rotational Speed
	2.668E-006
	4
	6.670E-007
	0.90
	0.0496

	Residual
	8.932E-006
	12
	7.443E-007
	
	

	Cor. Total
	1.244E-004
	24
	
	
	

	The model value 12.93 implies the model is significant 


Table 3.11 Anova Table for Reduction in Ra value data

3.4.9 Estimation of optimum response characteristics
The optimum value of characteristics is predicted at selected levels of significant parameters. The estimated mean of the response characteristics (MRR and ΔRa) can be computed as follows [15]:

nopt = Average performance + Contribution of significant factors at optimum levels

  = T + ( A4−T) + ( B5−T) + ( C3−T)
  =A4 + B5 + C3 - 2T

where T = average results of S/N ratio for MRR ; A4 S/N ratio value of VMR at forth level of current,B5 S/N ratio value for VMR at fifth level of number of cycles and C3 is the S/N ratio value at third level of rotational speed.
Substituting the values from table 6.4 into the various terms of above equation,

nopt   = (-87.676) + (-92.902) + (-97.623) - 2× (- 99.0977)
nopt = - 81.4803
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 = 7.11 × 10-9
yopt= 0.00008455 mm3
For [image: image145.png]


Ra  
nopt = Average performance + Contribution of significant factors at optimum levels

  = T + ( A5−T) + ( B5−T) + ( C2−T)
  =A5 + B5 + C2 - 2T

nopt = (- 46.2113) + (-43.4852) + (-47.6577) - 2× (-49.14636)
nopt= -39.0674  
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 =1.239 × 10-4
yopt = 0.0111 µm
RESULT AND DICUSSION                                                                                             4
4.1 Effect of process parameters on volumetric material removal

In order to see the effects of process parameters on the volumetric material removal, analysis has been done by using L25 OA (Table 3.2). The data is given in Table 3.4 and Table 3.5. The values of volumetric material removal for each parameter at levels 1, 2, 3, 4 and 5 for mean data and S/N data are plotted in Figures 3.11 and 3.12 respectively.

 Figure 3.12 show that volumetric material removal first increase with increase in current and attain a maximum value at point A4 , because with the increase in current in the electromagnet, magnetic field also increases forming strong chains of CIPs. Due to the increased bonding strength of the abrasive particles by the surrounding CIP chains, there is a lesser chance of disengagement of the abrasive particles, which are taking part in material removal so they increase the material removal. After A4 point the volumetric material removal starts to decline with further increase in current.
It is seen from the figure that the effect of number of cycles is significant on the volumetric material removal of the workpiece. As the number of cycles increases more number of magnetisable abrasive takes part in material removal and thus increases the material removal.VMR increases rapidly during the initial cycles, but during later cycles the increase is somewhat gradual. This is due to the fact that greater undulations are removed during the initial cycles when abrasive particles abrade against the peaks; later the peaks become somewhat flatter and the volumetric material removal reduces.

Figure 3.12 also shows the response of volumetric material removal with the increase in rotational speed. , it is seen from the figure that VMR starts increasing with the increase in rotational speed because the length of the path of motion of an abrasive particle per unit time also increases so, more number of surface peaks come in contact with the active abrasive grains, hence more amount of material is removed ,VMR reaches a maximum level to C3 and then starts decreasing because at high speed the magnetisable particle could not play their role effectively.
Figure 3.13 to 3.16 shows the residual plots for VMR. Residual plots are used to evaluate the data for the problems like non normality, non random variation, non constant variance, higher-order relationships, and outliers. It can be seen from Figures 3.13 and 3.15 that the residuals follow an approximately straight line in normal probability plot and approximate symmetric nature of histogram indicates that the residuals are normally distributed. Residuals possess constant variance as they are scattered randomly around zero in residuals versus the fitted values. Since residuals exhibit no clear pattern, there is no error due to time or data collection order.
Table 3.8 shows the ANNOVA analysis for the VMR data, which shows that model is significant with  p value = 0.0002.

Table 3.6 and Table 3.7 are the response tables for VMR and are used to calculate optimum process parameters. It is seen that optimum value of volumetric material removal  is 0.0000845 mm3 and it is at A4,B5 and C3.
4.2 Effect of process parameters on reduction in surface roughness
In order to see the effects of process parameters on the reduction in surface roughness, analysis has been done by using L25 OA (Table 3.1). The data is given in Table 3.4 and Table 3.5. The values of reduction in surface roughness for each parameter at levels 1, 2, 3, 4 and 5 for mean data and S/N data are plotted in Fig. 3.17and Fig. 3.18respectively.

Fig.3.17 shows that reduction in surface roughness increase with increase in current, because with the increase in current in the electromagnet, magnetic field also increases forming strong chains of CIPs. Due to the increased current, there is a lesser chance of rotation of the abrasive particles, which are taking part in removal of material getting higher reduction in surface roughness.

The reduction in surface roughness varies linearly with increase in number of cycles as shown in Fig. 3.17. As the number of cycles increases, number of times the abrasives come in contact with the workpiece increases, so the reduction of surface roughness increases.

As the rotational speed increases, ΔRa increases up to 4 rpm (fig 3.17) and attains an optimum value. Beyond the optimum value, though there is an increase in the rams rotational speed but much variation in ΔRa is not observed. As the rotational speed increases, the length of the path of motion of an MF polishing particle per unit time also increases so, more number of surface peaks come in contact with the active abrasive grains, hence more amount of material is removed. In otherwords, ΔRa is increased. However, beyond the optimum value, ΔRa starts slightly decreasing because the velocity at which the abrasive strikes the surface peak is high so, it might start creating deeper scratches leading to lower ΔRa.
Figure 3.19 to 3.22 shows the residual plots for VMR. Residual plots are used to evaluate the data for the problems like non normality, non random variation, non constant variance, higher-order relationships, and outliers. It can be seen from Figures 3.19 and 3.21 that the residuals follow an approximately straight line in normal probability plot and approximate symmetric nature of histogram indicates that the residuals are normally distributed. Residuals possess constant variance as they are scattered randomly around zero in residuals versus the fitted values. Since residuals exhibit no clear pattern, there is no error due to time or data collection order. 
Table 3.10 shows the ANNOVA analysis for the reduction in surface roughness data, which shows that model is significant with factor p value= 0.0001.

Table 3.8 and Table 3.9 are the response tables for reduction in roughness value and are used to calculate optimum process parameters. It is seen that optimum value of reduction in surface roughness is 0.0111µm and it is at A5, B5 and C2.
VALIDATION OF RMRAFF PROCESS MODEL                             5
5.1 Comparison of RMRAFF process with MRAFF process

For the validation of the RMRAFF process, a comparison has been done with MRAFF process. A model for the comparison has been developed and below given relation for surface roughness value is used to calculate the surface roughness value.
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 (5.1)
Values of the constants of Eq. (5.1) are ls=50mm, lw=35mm, rf=9mm, rc=28.75mm. 
For comparison, Surface roughness for ith cycle is calculated from Eq. (5.1) for different supply currents (1, 3, 5 and 6) through the electromagnet keeping Ns= 200 and rotational speed ω= 6 rpm as fixed and for different number of cycles (100, 200, 232 and 365) keeping current I=5A and rotational speed ω=6rpm as fixed. After substituting the above-mentioned values of the constants into Eq. (5.1). Output of surface roughness obtained after each cycle is used as initial value of surface roughness (i.e. input) for estimation of surface roughness during next cycle. The work piece material used is stainless steel.
A comparison of reduction in surface roughness values with magnetorheological abrasive flow finishing is given in Fig. 5.1 and Fig. 5.2. It is seen that reduction in surface roughness value increases with increase in current and number of cycles in both processes, but amount of reduction in surface roughness achieved in R-MRAFF process is greater than the MRAFF process. This validates our model for RMRAFF process.
	Number of cycles
	Reduction in Ra value(µm) for   MRAFF
	Reduction in Ra value(µm) for RMRAFF

	100
	0.01
	0.02

	 200
	0.04
	0.05

	232
	0.07
	0.08

	365
	0.1
	0.1054


Table 5.1 Table for variation in Reduction in Ra value with Current
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Fig 5.1 Variation of Reduction in Ra with number of cycles.
	Current(A)
	Reduction in Ra value(µm) for   MRAFF
	Reduction in Ra value(µm) for RMRAFF

	1
	0.01
	0.02

	 3
	0.03
	0.05

	5
	0.07
	0.09

	 6
	0.1
	0.11


Table 5.2 Table for variation in Reduction in Ra value with Current
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Fig.5.2 Variation of reduction in surface roughness with current.

In  R-MRAFF process centrifugal force acts on the MR polishing particles and hence MR polishing particles impinge upon the work surface material with greater resultant force. In case of MRAFF process, centrifugal force is absent and the MR polishing particles are acted upon by only magnetic force (keeping axial force constant in both processes).
In the case of the R-MRAFF process, both centrifugal force and magnetic force act on the MR polishing particles causing them to impinge at an angle on the work surface with the resultant force.
CONCLUSION AND SCOPE FOR FUTURE WORK                                                  6 
In the earlier chapters, the effects of process variables on response characteristics (volumetric material removal, and reduction in surface roughness value) of the rotational magneto rheological abrasive flow finishing (RMRAFF) process have been discussed. An optimal set of process variables yields the optimum quality features to machined parts produced by RMRAFF process has also been obtained. The important conclusions from the present work are summarized in this chapter.

6.1 CONCLUSION

· A three dimensional model for R-MRAFF has been developed using 3D Maxwell simulation software.

· Mathematical modelling of the R-MRAFF has been done for surface roughness and volumetric removal rate.

· The effects of the process parameters such as current, rotational speed and number of cycles on volumetric material removal and reduction in surface roughness value, has been studied.
· Volumetric material removal increases with the increase of current and reaches a maximum value at 4 A and then starts decreasing. VMR increases gradually with the increase in number of cycles. With rotational speed it increases with the increase in rotational speed, attains a maximum value at 6 rpm and then starts decreasing.
· Reduction in surface roughness value increase linearly with current and number of cycles. With rotational speed it increases initially with rotational speed and attains a maximum value and then it starts decreasing.
· The optimal set of process parameters has been obtained for various performance measures using Taguchi’s design of experiment methodology.
· Proposed methodology of R-MRAFF has been compared with MRAFF and found better results, and it is possible to enhance the productivity of MRAFF by giving rotational speed to the rams by attaching them together with a connecting rod.
6.2  SUGGESTION FOR FUTURE WORK

· The whole RMRAFF process model can be developed for experimental analysis of the process parameters.
· The effect of process parameters such as mesh size, viscosity of the medium, workpiece height etc. may also be investigated.
· RSM technique and utility function technique can be used to obtain the optimal conditions.
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APPENDIX A

	Current(A)
	Magnetic Force (N)

	0.5
	0.595×10-10

	1.0
	1.1010×10-10

	1.5
	2.9901×10-10

	2.0
	4.0699×10-10

	2.5
	6.081×10-10

	3.0
	9.1572×10-10

	3.5
	1.0620×10-9

	4.0
	1.62790×10-9

	4.5
	2.1010×10-9

	5.0
	2.5437×10-9
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Table A.1 table for magnetic force.             Fig.A.1 Variation of magnetic force with current.
The above shown graph shows that as the current increases the magnetic force acting on the particles increases.

APPENDIX B

Values   of total force, diameter of indentation and thickness of indentation which are used in the calculation of results for RMRAFF are given below:

	S.no
	Current


	No. Of cycles


	Rot. Speed (ω)
	Total Force (N)
	Di (µm)
	ti (µm)

	1
	1
	2
	2
	1.222E-10
	3.0467
	0.1270

	2
	1
	4
	4
	1.587E-10
	3.1764
	0.1337

	3
	1
	6
	6
	2.196E-10
	3.3151
	0.1457

	4
	1
	8
	8
	1.304E-10
	3.4871
	0.1614

	5
	1
	10
	10
	4.149E-10
	3.6972
	0.1816

	6
	2
	2
	4
	4.556E-10
	3.7722
	0.1891

	7
	2
	4
	6
	5.164E-10
	3.8270
	0.1942

	8
	2
	6
	8
	6.016E-10
	4.0657
	0.2200

	9
	2
	8
	10
	7.111E-10
	4.2107
	0.2362

	10
	2
	10
	2
	4.195E-10
	3.7054
	0.1824

	11
	3
	2
	6
	1.025E-09
	4.6914
	0.2941

	12
	3
	4
	8
	1.110E-09
	4.8124
	0.3098

	13
	3
	6
	10
	1.219E-09
	4.9638
	0.3305

	14
	3
	8
	2
	9.278E-10
	4.5475
	0.2761

	15
	3
	10
	4
	9.643E-10
	4.6021
	0.2829

	16
	4
	2
	8
	1.822E-09
	5.6338
	0.4272

	17
	4
	4
	10
	1.932E-09
	5.7619
	0.4474

	18
	4
	6
	2
	1.640E-09
	5.4120
	0.3935

	19
	4
	8
	4
	1.676E-09
	5.5479
	0.4140

	20
	4
	10
	6
	1.737E-09
	6.1789
	0.5164

	21
	5
	2
	10
	2.847E-09
	6.8029
	0.6298

	22
	5
	4
	2
	2.555E-09
	6.5153
	0.5760

	23
	5
	6
	4
	2.592E-09
	6.5520
	0.5827

	24
	5
	8
	6
	2.653E-09
	6.6128
	0.5940

	25
	5
	10
	8
	2.732E-09
	6.6970
	0.6097


Table B.1 table showing Di and ti for different forces

	Current(A)
	Magnetic Force(Fm)
	Di(µm)
	ti(µm)

	1
	0.1567E-13
	0.9377E-08
	1.1570E-12

	3
	1.3355E-13
	2.737E-08
	0.9861E-11

	5
	2.6814E-13
	3.8791E-08
	1.9861E-11

	6
	3.3915E-13
	4.3626E-08
	2.504E-11


Table B.2 Table for magnetic force for MRAFF process
	Current(A)
	Magnetic Force(Fm)
	Di(µm)
	ti(µm)

	1
	1.2160E-11
	2.6122E-08
	8.9788E-10

	3
	1.2293E-11
	2.626E-08
	9.6740E-10

	5
	1.2561E-11
	2.6550E-08
	9.2755E-10

	6
	1.2900E-11
	2.6906-08
	9.5259E-10


Table B.3 Table for magnetic force for RMRAFF process.
APPENDIX C

Material information

Brass

	Component 
	C
	Zn
	Pb
	Fe
	Others

	Wt. %
	60-63
	35.5
	2.5-3.7
	Max 0.35
	Max 0.5


Table D.1: material composition

Mechanical Properties
	Tensile Strenght,ultimate
	338-469MPa

	Tensile Strength,yield
	124-310MPa

	Modulus of elasticity
	97GPa

	Bulk modulus
	140Gpa

	Poisson ratio
	0.31

	Machinability
	100%

	Shear modulus
	37GPa


Table D.2 table showing mechanical properties of brass

1
27

